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Все проекты .:oomlout:. являются открытыми. Что это значит? Это значит, что все данные, 

необходимые для производства этого набора, доступны для бесплатного скачивания. И даже 

больше – вы тоже можете воспроизводить или менять любые материалы по своему 

усмотрению и затем распространять их. В чем смысл? Все просто, эти материалы выпущены 

под лицензией Creative Commons. Это значит, что, используя .:oomlout:., вы обязуетесь 

упоминать его в своих разработках и распространять их таким же образом. Почему? Мы 

выросли играя и учась с открытым программным обеспечением и это был хороший опыт, мы 

думаем этот подход оправдает себя и с реальными компонентами проектов (”железом”).

Более подробно о лицензии Creative Commons вы можете узнать по адресу 

http://ardx.org/CCLI

Об открытом аппаратном обеспечении

Введение

Об этом наборе
Основная цель этого набора – интересно и с пользой провести 

время. А помимо этого - освоить разнообразные электронные 

компоненты путем сборки небольших простых и интересных 

устройств. Вы получаете работающее устройство и инструмент, 

позволяющий понять принцип действия. Если у Вас что-то не 

получается, есть вопросы, либо Вам необходима дополнительная  

помощь – пишите нам на help@oomlout.com.

Об .: OOMLOUT :.

Мы отважная маленькая компания разработчиков, специализирующаяся на 

производстве «восхитительно прекрасной открытой продукции»
Наши свежие проекты можно увидеть по адресу:

http://www.oomlout.com

О проблемах
Мы стараемся поставлять товары высочайшего качества. Если Вы обнаружите неясную инструкцию, 

недостачу детали или просто захотите задать вопрос, мы сделаем все возможное, чтобы помочь Вам.

help@oomlout.com / help@solarbotics.com
(Мы предпочитаем знать о проблемах – это помогает нам улучшать последующие версии.)

Спасибо за то, что выбрали .:oomlout:.
(и Solarbotics)

О SOLARBOTICS

Мы начали производить робототехнические наборы BEAM больше 15 лет назад 

(правда-правда!), сейчас мы также поставляем классные электронные наборы

http://www.solarbotics.com/
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01 ASEM
собираем

компоненты

Макетная
плата
x1

Arduino
x1

4-40 x 3/8” винт
x3

4-40 гайка
x3

Основание 
для Arduino
x1

.: Сборка устройства :.

.: Для изучения основ Arduino посетите :.
.: http://ardx.org/INTR :.

#4 x 1/16”
шайба
x3

Вам понадобится 
как минимум два 
винта с гайками и 
шайбами для 
закрепления Arduino
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02 INST
installing 

(software and hardware)

.: Проблемы при установке? :.
.: Нужны подробности? Используете Linux? :.

.: http://ardx.org/LINU :.

Шаг 1: Загрузка программного
обеспечения

Откройте страницу  
http://arduino.cc/en/Main/Software

и загрузите версию для вашей операционной системы

Windows XP Mac OSX

Шаг 2: Распаковка архива
Программа

arduino-00 -win.zip 
Лучше всего в папку

c:\Program Files\

rr(rr- номер версии)

Шаг 3: Создание ярлыка
Откройте

c:\program files\arduino-00

Клик правой кнопкой мыши
Arduino.exe (send to>Desktop (создать ярлык))

rr\ rr- номер версии) (

Шаг 4: Подключение
Подключите Ваш Arduino при помощи 

USB-кабеля к свободному порту USB.

 На экране должно появиться 
диалоговое окно

Шаг 5: Добавление нового
оборудования

.: Установка программного 
обеспечения

(интерфейса пользователя IDE) :.
Интерфейс пользователя предназначен для программирования Arduino. Все это кажется 
поначалу немного сложным, но когда вы все установите и немного поиграете с программой 
– все ее секреты раскроются вам сами собой.

Шаг 5: Включите Arduino
Подключите Ваш Arduino при помощи USB-кабеля 

к свободному порту USB

Шаг 2: Откройте.dmg
Откройте (загрузите)

arduino-00 -mac.dmg rr(rr- номер версии)

Шаг 4: Установите драйверы
.:Только для плат Duemilanove:.

Найдите
"Arduino" device

FTDI Drivers for Intel Macs ( _ _ ).pkg
(FTDI Drivers for PPC Macs ( _ _ ).pkg

Перезагрузитесь

Двойной щелчок мышью, установите:
rrrr

rrrr

Шаг 3: Скопируйте 
приложение

Найдите
"Arduino" (в секции браузера “devices”)

Переместите
Приложение "Arduino" в папку 

"Applications" (приложения)

02 INST
инсталляция

(программное и аппаратное
обеспечение)

Vista, Seven

Шаг 5: Добавление нового
оборудования

Пропустите  опцию “поиск драйверов в 
интернете” (просто щелкните “next” )

Далее 
щелкните “Install from a list or specific location 

(Advanced)")
Установочные директории

Duemilanove Board
c:\program files\arduino-00

c:\program files\arduino-00

rr\drivers\FTDI USB Drivers\

Uno Board

rr\drivers\

Запустите Device Manager
Start > Run > devmgmt.msc

Выберите Arduino
Other Devices > Arduino Uno (Uno) 

Обновите драйвер
щелкните “Update Driver”

Выберите 
щелкните “Browse My Computer for Driver Software”

c:\program files\arduino-00

драйвер

rr\drivers\
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03 PROG
программи-

рование

.: Небольшая справка
по программированию:.

СТРУКТУРА

Синтаксис

Основы программирования Arduino

Переменные

// (однострочный 

комментарий)
Часто используется для 

размещения в тексте программы 

комментариев. Можно пояснять, 

что значит каждая строка 

программы. Все что размещается 

после двойной черты и до конца 

строки будет игнорироваться 

компилятором.

{ } (фигурные скобки)

Используются для определения 

начала и конца блока команд 

(используются в функциях и 

циклах).

void setup(){  }
Все команды, заключенные 

между фигурными скобками, 

выполняются только один раз, 

при первом запуске программы.

Каждая программа Arduino 

(часто называемая «скетч») 

имеет две обязательные 

функции (также называемые 

подпрограммами).

void loop(){  }
Эта подпрограмма выполняется 
циклически вплоть до 
отключения питания, после 
завершения подпрограммы 
setup(). 

; (точка с запятой)

Каждая команда должна 

заканчиваться этим символом 

(потерянная точка с запятой — 

наиболее распространенная 

ошибка, приводящая к 

невозможности компиляции).

Требования к 

форматированию в языке 

С вызывают некоторые 

затруднения у 

начинающих (с другой 

стороны, благодаря своей 

структуре, язык С 

обладает большими 

возможностями). Если Вы 

запомните следующие 

правила, этого будет 

вполне достаточно.

/*  */(многострочный 

комментарий). Вы можете 

использовать эту структуру, если 

Вам надо создать подробный 

комментарий на нескольких 

строках. Все находящееся между 

этими символами будет 

игнорироваться компилятором.

Любая программа всего 

лишь определенным образом 

манипулирует числами. 

Переменные помогают 

жонглировать цифрами.

long (длинная)
Используется в том случае, 

когда не хватает емкости int. 

Занимает в памяти 4 байта (32 

бита) и имеет диапазон -2 147 

483 648 … 2 147 483 647.

int (целочисленная)
Основная рабочая лошадка, 
хранится в памяти с 
использованием двух байт (16 
бит). Может содержать целое 
число в диапазоне -32 768 … 
32 767.

boolean (двоичная)
Простой тип переменной 

типа True/False. 

Занимает только 

один бит в 

памяти.

char (символ)Хранит один 

символ, используюя 

кодировку ASCII (например 

«A» =65). Использует один 

байт памяти (8 бит). Arduino 

оперирует со строками как с 

массивами символов.

float (с плавающей 

запятой)
Используется для вычислений с 

плавающей запятой. Занимает в 

памяти 4 байта (32 бита) и 

имеет диапазон -3.4028235Е+38.

Arduino программируется на языке С. Данный раздел ориентирован на тех, кто имеет 

небольшой опыт программирования, и нуждается только в пояснении особенностей языка 

С и интерфейса Arduino. Если все это кажется Вам немного сложным, не беспокойтесь, 

начинайте работать с примерами устройств и понимание придет в процессе. Для более 

подробного изучения основ используйте сайт arduino.cc.
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03 PROG

рование
программи-

Математические операторы

Операторы сравнения

Управляющие структуры

Цифровые сигналы

Аналоговые сигналы

.:Для более подробной справки по 
программированию посетите:.

http://ardx.org/PROG

= (присвоение) делает что-то равным чему-то(например 

х=10*2 записывает в переменную х число 20).
% остаток от деления). Например 12%10 дает результат 2.
+   (сложение)
- (вычитание)
* (умножение)
/ (деление)

Операторы 
используются для 
преобразования чисел.

== (равно) (Например 12==10 не верно (FALSE), 5==5 верно(TRUE).)

!= (не равно) (Например 12!=10 верно (TRUE), 5!=5 не верно (FALSE).)

< (меньше) (Например 12<10 не верно (FALSE), 12<12 не верно (FALSE), 

12<14 верно (TRUE).)

> (больше) (Например 12>10 верно (TRUE), 12>12 не верно (FALSE), 

12>14 не верно (FALSE).)

Операторы, 

используемые для 

логического сравнения.

if (условие 1) {}
else if (условие 2) {}
else {}

Если условие 1 верно (TRUE) 
выполняются команды в первых фигурных 
скобках. Если условие 1 не верно (FALSE) 
то проверяется условие 2. Если условие 2 
верно, то выполняются команды во 
вторых фигурных скобках, в противном 
случае выполняются команды в третьих 
фигурных скобках.

Для определения порядка 

выполнения команд (блоков 

команд) служат управляющие 

структуры. Здесь приведены 

только основные структуры. 

Более подробно можете 

ознакомиться на сайте 

Arduino.

for (int i=0; 
i<число повторов; 
i++) {}

Эта структура 

используется для 

определения цикла. Цикл 

повторяется заданное 

число раз. Переменная i 

может увеличиваться или 

уменьшаться.

analogWrite(pin,value);
Некоторые порты Arduino (3,5,6,9,10,11) 
поддерживают режим ШИМ (широтно-
импульсной модуляции). В этом режиме 
в порт посылаются логические единицы 
и нули с очень большой скоростью. 
Таким образом среднее напряжение 
зависит от баланса между количеством 
единиц и нулей и может изменяться в 
пределах от 0 (0В) до 255 (+5В).

Arduino - цифровое 

устройство, но может 

работать и с 

аналоговыми 

сигналами при 

помощи следующих 

двух команд:

analogRead(pin);

Если аналоговый порт настроен в 

режим INPUT, то можно измерить 

напряжение на нем. 

Может принимать 

значения от 0 

(0В) до 1024 

(+5В).

digitalRead(pin); 
Если порт установлен 

в режим INPUT эта 

команда возвращает 

значение сигнала на 

входе HIGH или LOW.

pinMode(pin, mode);
Используется, чтобы определить режим 

работы соответствующего порта. Вы 

можете использовать адреса портов 

0...19 (номера с 14 по 19 используются 

для описания аналоговых портов 0...5). 

Режим может быть или INPUT (вход) или 

OUTPUT (выход).

digitalWrite(pin, value);
Если порт установлен в режим 

OUTPUT, в него можно 

записать HIGH (логическую 

единицу, +5В) или LOW 

(логический ноль, GND).



Коллекторный
двигатель

Сервопривод
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04 ELEC
электроника

.: 

по электронике:.

Небольшая справка 

Основы электроники

Описание компонентов
LED 
(светодиод)

Резистор

Транзистор

Диод

Что делает: Число выводов:
Вращается, когда через него 2
протекает электрический ток. Важно:
Вид: Используйте транзистор или реле 
Это просто, он выглядит как мотор. соответствующей мощности для 
Обычно цилиндрической формы с подключения двигателя.
осью посередине. Дополнительная информация:

  http://ardx.org/MOTO

Что делает: Число выводов:
Преобразует электрические импульсы 3
в угол поворота оси. Важно:
Вид:  Убедитесь в правильном 
Пластиковая коробочка с тремя подключении (разъем без ключа).
проводками и металлической осью с Дополнительная информация:
кронштейном.   http://ardx.org/SERV

Вам не потребуется опыт работы с электроникой для работы с этим набором. Ниже 
приведены некоторые сведения об электронных компонентах, которые позволят Вам 
легче их идентифицировать и возможно, понять принцип действия. Если Вам что-либо 
не понятно или компонент работает не так как должен — обращайтесь в нашу службу 
поддержки по адресу help@oomlout.com

Что делает: Число выводов: 2 
(более длинный вывод (анод) подключается к Излучает свет если пропустить через 
положительному потенциалу)него небольшой ток. Ток может проходить 
Важно:через светодиод только в одном направлении.

Работает только при правильном Вид:
включении. Требуется резистор для Похож на небольшую лампочку.
ограничения силы тока.

Дополнительная информация:
  http://ardx.org/LED

Что делает: Число выводов: 2
Ограничивает силу тока, протекающего Важно:
в цепи.

Легко перепутать номинал. Тщательно 
Вид: Обычно цилиндрической формы с проверяйте значение. 

выводами на противоположных Дополнительная информация:
сторонах. Значение номинала указывается при   http://ardx.org/RESI
помощи цветных полосок (информацию о 

цветовой кодировке смотри далее).

Что делает: Число выводов:
Используется для коммутации или 3 (База, Коллектор, Эмиттер)
усиления сигналов. Важно:
Вид: Не путать выводы. Для ограничения 

тока часто используются резисторы.  Выпускается в разнообразных 
Дополнительная информация:корпусах. Название обычно наносится 
  http://ardx.org/TRANна корпус (в данном наборе используются 

P2N2222AG)

Что делает: Число выводов: 2 
Электронный эквивалент Важно:
однонаправленного клапана. Ток через Пропускает ток только в одном 
диод может течь только в одну сторону. направлении. Ток будет течь, если сторона с 
Вид: полоской подключена к низкому потенциалу, а другая 

сторона к более высокому.Обычно цилиндрической формы с 
Дополнительная информация:выводами на противоположных 
  http://ardx.org/DIODсторонах (на одной из сторон нанесена линия, 

определяющая полярность).
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04 ELEC
электроника

Пьезоэлемент

Потенциометр

IC (интегральная микросхема)

Фоторезистор

Кнопка

0 - черный 5 - зеленый 20% - нет полоски

1 - коричневый 6 - синий 10% - серебряный

2 - красный 7 - фиолетовый 5% - золотой

3 - оранжевый 8 - серый

4 - желтый 9 - белый

первая цифра

вторая цифра

число нулей

точность
номинала

Примеры:
зеленый-голубой-коричневый = 560 Ом
красный-красный-красный = 2 200 Ом = 
2.2 кОм
Коричневый-черный-оранжевый = 10 000 
Ом = 10 кОм

Цветовая кодировка резисторов Обрезка выводов

Описание компонентов (продолжение)

Что делает: Число выводов: 2
Импульс тока преобразуется в щелчок. Важно:
Последовательность импульсов   Трудно подключить неправильно.
преобразуется в музыкальный тон. Дополнительная информация:
Вид: В этом наборе он выглядит как   http://ardx.org/PIEZ
черный бочонок. Иногда может 

выглядеть как золотой диск.

Что делает: Число выводов: 
Резистор с номиналом, величина 3
которого зависит от угла поворота оси. Важно:
Вид: Может иметь линейную или 
Выпускается в разнообразных логарифмическую шкалу.
корпусах. Дополнительная информация:

  http://ardx.org/POTE

Что делает: Число выводов: 
Содержит в себе электронику любой от двух до нескольких сотен. В этом наборе 

TMP36 имеет 3 вывода и 74HC595 имеет 16 сложности. 
выводов.Вид:
Важно:Название компонента обычно нанесено на 

Не перепутать ориентацию микросхемы.корпус (часто для того чтобы прочитать требуется 
Дополнительная информация:увеличительное стекло или хорошее освещение).

  http://ardx.org/ICIC

Что делает: Число выводов: 
Резистор с номиналом, величина 2
которого зависит от интенсивности Важно: Чтобы получить полезный 
падающего на него света. сигнал, необходимо использовать 
Вид: фоторезистор как часть делителя 
Обычно выглядит как небольшой диск с напряжения.
прозрачным покрытием и Дополнительная информация:
зигзагообразным проводником под ним.   http://ardx.org/PHOT

Что делает: Число выводов: 

Замыкает контакты при нажатии. 4

Вид: Важно:

Маленький квадратик с выводами   Практически квадратная, можно 

внизу и кнопкой наверху. вставить с поворотом на 90 градусов.

Дополнительная информация:

  http://ardx.org/BUTT

Некоторые компоненты в этом наборе поставляются с 

очень длинными выводами. Для более удобного 

использования можно сделать следующие изменения:

Светодиоды:

Укоротите длинный вывод до 10 мм, короткий — до 7. 

Резисторы:

Согните выводы вниз под углом 90° и укоротите до 6 

мм.

Остальные компоненты:

У остальных компонентов можете 

укоротить выводы по своему 

усмотрению.
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CIRC-01

Описание задания:

.:Начнем работу:.
.:(мигающий светодиод):.

Провод
Светодиод
10мм
x1

Резистор 
зеленый-синий-коричневый
x1

560 Oм

х2 контактный
разъем
x4

Карточка задания
CIRC-01 
x1

Arduino 
разъем 13

LED
(светодиод)

резистор (560ом)
(зеленый-синий-
коричневый)

общий вывод
(ground) (-)

Компоненты:

.:скачать:.
карточку задания

http://ardx.org/BBLS01
.:посмотреть:.
видео сборки

http://ardx.org/VIDE01

в Интернете:

длинный
вывод

+

УСТРОЙСТВО:

Схема

Светодиоды очень широко используются в различных 

устройствах, поэтому мы и добавили их в этот набор. Начнем 

с чего-то очень простого, например будем включать и 

выключать светодиод в бесконечном цикле. Отберите детали по 

списку, прикрепите карточку задания к макетной плате, установите 

все детали. После сборки устройства, необходимо загрузить программу. Для этого 

подключите Arduino к свободному порту USB. Затем установите порт в программе 

Tools>Serial Port>(порт, назначенный для Arduino). Загрузка программы осуществляется 

из меню File>Upload to I/O Board (ctrl+U). Наконец, наслаждайтесь способностью 

контролировать светодиод!

Если Вы столкнулись с проблемами при загрузке — обратитесь к руководству: http://ardx.org/TRBL
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CIRC-01
File > Examples > 1.Basic > Blink
(это пример с сайта arduino.cc, также там можно найти много отличных идей)

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC01

Все еще не работает?

Неисправное оборудование 

это неприятно, пошлите нам 

e-mail с описанием 

проблемы и мы свяжемся с 

Вами как можно скорее.

help@oomlout.com

Программа не загружается?

Это случается иногда. Чаще 

всего причиной является 

неправильно указанный 

последовательный порт. 

Изменить порт можно в меню 

tools>serial port>

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

ЕСТЬ ЕЩЕ ВОПРОСЫ?

Светодиод не зажигается?
Светодиод работает только при 

соблюдении правильной 
полярности. Попробуйте 
вытащить его и вставить 

наоборот. Не беспокойтесь — 
неправильное включение не 

должно его повредить. 
Убедитесь, что подключили его 

к порту номер 13.

Поменяем управляющий порт: Управление яркостью свечения:

Кроме простого включения и выключения можно Светодиод подключен к порту 13, однако мы можем
контролировать яркость свечения светодиода (болееиспользовать любой из портов Arduino. Переключите
подробно это будет объясняться в последующих провод на любой порт по Вашему выбору (от 0 до 13,
заданиях). Подключите светодиод к порту номер 9:

или аналоговые порты — от 14 до 19). Затем
int ledpin = 13; замените на int ledpin = 9;замените команду:

 int ledpin = 13; на int ledpin = ваш номер;
Замените код в фигурных скобках процедуры loop()

Загрузите программу в Arduino (ctrl-u).
следующим:

Изменим частоту мигания: analogWrite(ledPin, new number);
Для изменения времени включения и выключения — newnumber – любое число из диапазона 0...255. 0 будет
редактируйте аргументы функции delay(x). Задержка соответствовать отключенному светодиоду, 255 —
определяется как х = число секунд * 1000. максимальная яркость.

Например: для задания более низкой частоты 
Плавное изменение яркости:

мигания программа должна выглядеть следующим
Откройте пример: 

образом:
File > Examples > 3.Analog > Fading

digitalWrite(ledpin,HIGH); Загрузите эту программу в Arduino и посмотрите
delay(2000); получившийся эффект.
digitalWrite(ledpin,LOW);
delay(2000);

КОД не надо набирать вручную, он находится по адресу:

/* Мигание
 * включает светодиод на 1 секунду, выключает на 1 секунду, 
 * функция вызывается по кругу
 * Created 1 June 2005 By David Cuartielles
 * http://arduino.cc/en/Tutorial/Blink
 * based on an orginal by H. Barragan for the Wiring i/o board
 */

int ledPin =  13;    // светодиод подключен к выходу 13

// Функция начальных установок setup() вызывается 1 раз в начале скетча
void setup()   {                  // устанавливаем 13 контакт в режим вывода:
  pinMode(ledPin, OUTPUT);     }

// функция loop() вызывается по кругу
// пока Arduino подключен к питанию
void loop()                     {
  digitalWrite(ledPin, HIGH);   // включение светодиода
  delay(1000);                  // задержка 1 сек
  digitalWrite(ledPin, LOW);    // выключение светодиода
  delay(1000);                  // задержка 1 сек
}



Провод

10

CIRC-02
.:Схема

с 8 светодиодами:.

Светодиод 
зеленый
x8

5мм,

Резистор 560 Oм
Зеленый-синий-коричневый
x8

х2 контактный
разъем
x4

Карточка задания
CIRC-02 
x1

.:скачать:.
карточку задания

http://ardx.org/BBLS02
.:посмотреть:.
видео сборки

http://ardx.org/VIDE02

светодиод

резистор
560oм

gnd

кон-
такт3

кон-
такт2

кон-
такт4

кон-
такт5

gnd

кон-
такт7

кон-
такт6

кон-
такт8

кон-
такт9

Компоненты:

в Интернете:

УСТРОЙСТВО:

Схема

Описание задания:

Мы заставили светодиод мигать, время поднимать 

ставки! Давайте подключим сразу восемь светодиодов. У 

нас также будет возможность создать несколько 

различных световых эффектов. Это устройство — хорошая 

основа для дальнейших экспериментов и освоения Arduino.

Одновременно с управлением светодиодами рассмотрим методы оптимизации 

программы.

for() loops - используется, если Вам необходимо выполнить часть программы 

несколько раз.

arrays[] - используется для упрощения работы с переменными (фактически это 

группа переменных).

светодиод

резистор
560oм
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CIRC-02
его можно загрузить с 
(скопируйте текст и вставьте его в новое окно Arduino Sketch)

http://ardx.org/CODE02

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC02

//переменные светодиодов светодиод,  задержка на 
int ledPins[] = {2,3,4,5,6,7,8,9}; delayTime, включение 
              //множество, задающее какой             следующего светодиодиода, 

//светодиод присоединен к какому выключение
//порту, например светодиод №0 - к 
//порту2                                                              void oneAfterAnotherNoLoop(){

  int delayTime = 100; 
void setup()      //время задержки между включениями
{      //светодиодов в миллисекундах 
  for(int i = 0; i < 8; i++){      digitalWrite(ledPins[0], HIGH);  
     //цикл повторяющийся 8 раз        //включение светодиода №0
    pinMode(ledPins[i],OUTPUT);        //на выходе 2
     //устанавливает порты, к которым подключены                                  
     //светодиоды, в режим вывода   delay(delayTime);     //задержка на delayTime
  }                                                           //(в миллисекундах)
}   ...

  ...
void loop()          // бесконечный цикл   digitalWrite(ledPins[7], HIGH);
{ //включение светодиода №7 на выходе 9
  oneAfterAnotherNoLoop();                        
      //включает каждый светодиод по одному и   delay(delayTime);    

//затем так же выключает //задержка на delayTime (в миллисекундах)  
  //oneAfterAnotherLoop();   //выключение каждого светодиода
  //делает то же самое что  oneAfterAnotherNoLoop
  //но команда короче   digitalWrite(ledPins[7], LOW);  //выключение 
  //oneOnAtATime();          ветодиода №7
  //inAndOut();                 delay(delayTime);    //задержка на delayTime
}                         //(в миллисекундах)

  ...
/*
 * oneAfterAnotherNoLoop() - зажигает один -----полная программа в электронной версии------        

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

ЕСТЬ ЕЩЕ ВОПРОСЫ?

Светодиоды загораются 
в неправильном порядке

При подключении восьми 

проводов легко можно 

перепутать пару. Убедитесь, что 

первый светодиод подключен к 

порту 2 и каждый последующий 

к следующему порту по 

порядку.

Некоторые светодиоды 
не загораются

 Легко ошибиться и вставить 

светодиод наоборот. Проверьте 

полярность всех неработающих 

светодиодов.

Использование циклов: использует структуру for).

В функции loop() записаны четыре команды. Дополнительные эффекты:
Последние три начинаются с символа «//». 

Устали от этого эффекта? Попробуйте два других 
Это значит, что компилятор игнорирует эти 

образца. Убирайте поочередно значки 
строки (рассматривает их как комментарий). комментария («//») с двух последних строк, 
Для использования циклов измените текст загружайте программу в Arduino и любуйтесь 
программы следующим образом: новыми эффектами.
  //oneAfterAnotherNoLoop();   

Создайте свой собственный эффект:  oneAfterAnotherLoop();   
  //oneOnAtATime();        Попробуйте изменить что-нибудь в программе. 
  //inAndOut(); Основная идея во включении светодиодов 
Загрузите программу в Arduino и обратите командой digitalWrite(pinNumber,HIGH); и 

внимание, что программа исполняется так же. выключении при помощи команды 

digitalWrite(pinNumber,LOW); Не бойтесь Обратите внимание на эти две функции, они 
экспериментировать, вне зависимости от того, что выполняют одно и то же, но с использованием 
Вы измените, ничего не должно сломаться!различных принципов (вторая функция 

Начните сначала
Часто проще все разобрать и 

собрать заново, чем искать 

неисправность.

КОД не надо набирать вручную,
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CIRC-03
.:Крутись мотор,

крутись:.
.:Транзистор и мотор:.

Провод
Транзистор
P2N2222AG  (TO92)
x1

Резистор 2.2k  Oм
Красный-красный-красный
x1

х2 контактный
разъем
x4

Карточка задания
CIRC-03 
x1

Коллекторный
двигатель
x1

Arduino 
разъем 9

резистор
(2.2кОм)

общий вывод
(ground) (-)

коллектор эмиттер

база

мотор

+5 Вольт

транзистор
P2N2222AG 

транзистор маркирован
“P2N2222AG”
(у некоторых разновидностей
выходы расположены
в обратном порядке)

Диод
(1N4001)
x1

диод

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS03
посмотреть

http://ardx.org/VIDE03

Компоненты:

в Интернете:

УСТРОЙСТВО:

Схема

Описание задания:
Порты Arduino идеально подходят для управления чем-то 
маленьким с небольшим потреблением (например светодиод). 
Таким образом, для управления большими нагрузками (например 
моторами) требуется использовать дополнительный элемент — 
транзистор. Транзистор очень полезный элемент, он позволяет 
управлять большими нагрузками и при этом потребляет совсем 
небольшой ток. Транзистор имеет три вывода. Для транзисторов типа NPN Вы должны 
подключать нагрузку к коллектору, а эмиттер к «земле» (нулевому потенциалу). Если от базы к 
эмиттеру будет протекать небольшой ток (если подключить к базе сигнал HIGH от Arduino), то 
транзистор «откроется», ток потечет через транзистор и мотор начнет вращаться. Существует 
великое множество транзисторов, позволяющих решать самые разнообразные задачи. В наборе 
используются транзисторы общего применения P2N2222AG. Максимальное напряжение, с которым 
может работать этот транзистор, составляет 40В, максимальный ток — 600 мА. Эти параметры 
позволяют использовать его с нашим мотором. Более подробно можете параметры транзистора 
приведены по адресу:  http://ardx.org/2222).
В качестве защиты от обратного тока используется диод 1N4001. Более подробно про это рассказано по адресу: http://ardx.org/4001)

.:Примечание: если при запуске мотора Аrduino перезагружается или зависает, 
тогда необходимо установить дополнительный конденсатор:.
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CIRC-03

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC03

его можно загрузить с 
(скопируйте текст и вставьте его в новое окно Arduino Sketch)

http://ardx.org/CODE03

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

Все ещё не работает?
Если Вы используете свой 

собственный мотор, 

убедитесь, что он может 

работать от напряжения 5В и 

не потребляет слишком 

много.

Мотор не вращается? 
Если Вы используете свой 

собственный транзистор, 

убедитесь что расположение 

выводов совпадает с 

P2N222A. Многие 

транзисторы имеют другое 

расположение выводов.

Контроль скорости: Загрузите программу в Arduino. Вы можете изменять 
Ранее мы рассматривали возможность управления скорость путем редактирования переменных onSpeed и 
яркостью светодиодов при помощи Arduino. Этот же offSpeed.
принцип можно использовать для управления 

Ускорение и замедление:скоростью вращения мотора. Arduino формирует 
Зачем останавливаться на двух фиксированных сигналы, называемые ШИМ (широтно-импульсная 
скоростях? С использованием этой технологии можно модуляция). На выход с высокой частотой поступает 
ускорять и замедлять мотор. Для проверки этого последовательность логических нулей и единиц. 
измените текст программы в функции loop() следующим Баланс между количеством единиц и нулей 
образом:определяет результирующее напряжение. 
// motorOnThenOff();Например, для формирования напряжения 2,5 В 
// motorOnThenOffWithSpeed();необходимо чтобы за единицу времени количество 
   motorAcceleration();нулей равнялось количеству единиц.
Загрузите программу и Вы увидите, как мотор плавно В функции loop() измените текст программы 
разгоняется до максимальной скорости, а затем плавно следующим образом:
тормозит. Если Вы хотите поменять скорость разгона, то // motorOnThenOff();

   motorOnThenOffWithSpeed(); изменяйте переменную delayTime (большее значение 
// motorAcceleration(); соответствует более медленному разгону).

Снова не работает?
Иногда Arduino 

самопроизвольно 

отключается от компьютера. 

Попробуйте отключить и 

затем подключить обратно 

кабель USB Arduino.

int motorPin = 9; //мотор подсоединен к разъему 9
                  void motorOnThenOffWithSpeed(){
void setup() //запускается единожды   int onSpeed = 200;
{ // число между 0 (остановка) и 255 (максимальная скорость) 
 pinMode(motorPin, OUTPUT);   int onTime = 2500;    
}   int offSpeed = 50;

// число между 0 (остановка) и 255 (максимальная скорость)
void loop()        // выполняется бесконечно   int offTime = 1000;   
{   analogWrite(motorPin, onSpeed);   
 motorOnThenOff();       // включение мотора
 //motorOnThenOffWithSpeed();   delay(onTime);      // задержка на onTime миллисекунд
 //motorAcceleration();   analogWrite(motorPin, offSpeed);  
}       // выключение мотора

  delay(offTime);    // задержка на offTime миллисекунд
/* motorOnThenOff() - включает мотор затем }

выключает его (обратите внимание что код идентичен 
void motorAcceleration(){

тому что мы использовали для мигающего светодиода)     int delayTime = 50; //
*/   for(int i = 0; i < 256; i++){
void motorOnThenOff(){        //изменяет скорость от 0 до 255
  int onTime = 2500;    analogWrite(motorPin, i);   //sets the new speed
//время во включенном состоянии    delay(delayTime);// задержка на delayTime миллисекунд
  int offTime = 1000;   }
//время в выключенном состоянии   for(int i = 255; i >= 0; i--){
  digitalWrite(motorPin, HIGH);        //
                 // включение мотора     analogWrite(motorPin, i);   //sets the new speed
  delay(onTime);     delay(delayTime);//задержка на delayTime миллисекунд
// задержка на onTime миллисекунд   }
  digitalWrite(motorPin, LOW);  }
                 // выключение мотора
  delay(offTime);// offTime 
}

 

задержка на миллисекунд

задержка между скоростями

изменяет скорость от 255 до 0

КОД не надо набирать вручную,

ЕСТЬ ЕЩЕ ВОПРОСЫ?
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CIRC-04
.:Одиночный
сервопривод:.

Провод

х3 контактный
разъем
x1

Сервопривод
x1

х2 контактный
разъем
x4

Карточка задания
CIRC-04
x1

Arduino 
 9разъем

общий вывод
(ground) (-)

gnd
(черный/

коричневый)

сигнал
(оранжевый)

+5v
(крас-
ный)

сервопривод

+5 Вольт
(5V)

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS04
посмотреть

http://ardx.org/VIDE04

Описание задания:

Компоненты:

в Интернете:

УСТРОЙСТВО:

Схема

Крутить мотор достаточно интересно, но когда мы делаем 

проект, в котором необходим контроль движения, 

хочется чего-то большего. Рассмотрим пример управления 

сервоприводом. Сервоприводы массово производятся, 

легко доступны, стоимость составляет от пары долларов до 

сотен. Внутри сервопривода встроен небольшой редуктор (чтобы увеличить мощность) 

и электроника (для упрощения управления). Стандартный сервопривод 

позиционируется от 0 до 180 градусов. Позиция задается длительностью 

управляющего импульса, от 1.25 мс (0 градусов) до 1.75 мс (180 градусов, 1.5 мс для 

90 градусов). Временные параметры могут отличаться у различных производителей. 

Если посылать импульсы каждые 25...50 мс, то сервопривод может плавно вращаться. 

Одним из преимуществ Arduino является готовая к использованию библиотека 

подпрограмм, позволяющая легко управлять двумя сервоприводами (подключенными 

к портам 9 и 10).
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CIRC-04
File > Examples > Servo > Sweep
( )это пример с сайта arduino.cc, также там можно найти много отличных идей

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC04

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

Все еще не 

работает?
Не забывайте про питание! 

Красный и коричневый 

проводники должны быть 

подключены к +5В и к 

«земле» соответственно.

Сервопривод не 

вращается?

Даже с цветовой 

маркировкой проводов их 

по-прежнему легко можно 

перепутать. Возможно 

причина в этом.

  int pulseTime = 2100;Управление потенциометром:
//величина задержки в микросекундах

Мы еще не экспериментировали со входами, но если //900 для 0 градусов, 1500 для 90 градусов, 
//2100 для 180 градусов 

хотите попробовать, то загрузите пример File  > Servo >   digitalWrite(servoPin, HIGH);
  delayMicroseconds(pulseTime);Knob. В этом примере для управления сервоприводом 
  digitalWrite(servoPin, LOW);
  delay(25);используется потенциометр (CIRC08). С пояснениями 
}

можно познакомиться по адресу: http://ardx.org/KNOB

Интересные идеи:
Прямое управление: Сервопривод может использоваться во многих интересных 
Управлять сервоприводом очень легко при помощи 

проектах. Приведем несколько примеров:
библиотеки подпрограмм. Но иногда необходимо 

Рождественский счетчиксамостоятельно создать программу для управления. 
http://ardx.org/XMASМожно непосредственно управлять сервоприводом, если 

посылать импульс заданной длительности на любой порт 
Манипулятор робота (открытый проект с использованием 

Arduino. Образец программы: сервоприводов и Arduino)
http://ardx.org/RARM  int servoPin = 9;

void setup(){
  pinMode(servoPin,OUTPUT);

Шагающий робот с сервоприводами}
void loop() { http://ardx.org/SEWA

// Поворот сервопривода (by BARRAGAN <http://barraganstudio.com>) 

#include <Servo.h>  
Servo myservo;  // создание объекта “серво” для контроля сервопривода
int pos = 0;    // переменная для хранения позиции серво

void setup() {   
  myservo.attach(9);  // назначает вывод 9 как управляющий для объекта серво
}

void loop() {   
  for(pos = 0; pos < 180; pos += 1)// перемещается от 0° до 180  с шагом в 1
    myservo.write(pos);          //команда сервоприводу 

//перейти в позицию с переменной 'pos'        
    delay(15);                   // задержка 15мс for the servo to reach the 
position    
  }
  for(pos = 180; pos>=1; pos-=1) // перемещается от 180° до 0°    
  {                                    
    myservo.write(pos);          //команда сервоприводу 

//перейти в позицию с переменной 'pos'     
    delay(15);                   // задержка 15мс для достижения заданной позиции
  }
} 

° °

Если сервопривод двигается 

рывками

Если сервопривод дергается и 

светодиод питания на Arduino 

мигает, возможно мощность 

источника питания недостаточна. 

Попробуйте использовать 

питание от внешнего источника, 

а не от USB.

КОД не надо набирать вручную, он находится по адресу:

ЕСТЬ ЕЩЕ ВОПРОСЫ?
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CIRC-05
.:Еще 8 светодиодов

(сдвиговый
регистр 74HC595):.

Провод

Микросхема
сдвигового
регистра 
74HC595
x1Резистор 560 Oм

Зеленый-синий-коричневый
x8

х2 контактный
разъем
x4

Карточка задания
CIRC-05 
x1

Красный
светодиод
x8
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кон-
такт

4

0

1
2

3

4

5

6

7

data
clock
latch

+5В

gnd

74HC595

Выемка в форме полумесяца
должна быть вверху

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS05
посмотреть

http://ardx.org/VIDE05

Описание задания:

Компоненты:

в Интернете:

УСТРОЙСТВО:

Схема

Пришло время познакомиться с микросхемами. Внешний вид микросхемы 

может быть очень обманчивым. Например, микросхема контроллера на плате 

Arduino и микросхема сдвигового регистра выглядят очень похоже, хотя по 

сути очень сильно отличаются. Цена микроконтроллера ATMega составляет 

несколько долларов, в то время как цена сдвигового регистра 74HC595 — 

несколько центов. Освоение сдвигового регистра - хорошее начало, и если Вы 

разберетесь как им управлять и как работать с документацией (http://ardx.org/74HC595), то Вам уже будет не 

страшен мир микросхем. Сдвиговый регистр (также называется преобразователем последовательного интерфейса 

в параллельный) дает Вам 8 дополнительных цифровых выходов (для управления светодиодами или чем-то 

подобным) используя только три порта Arduino. Также эти регистры можно соединять последовательно, что 

позволяет организовать практически неограниченное число выходов, при использовании тех же трех портов 

Arduino. Для использования сдвигового регистра необходимо записать в него значение через последовательный 

интерфейс и затем выдать его на выход через параллельный интерфейс. Последовательный интерфейс 

представляет собой два входа: вход данных и вход тактов. Для передачи байта данных через такой интерфейс 

необходимо поочередно устанавливать на входе сдвигового регистра уровни, соответствующие значениям битов 

байта и посылать импульс на тактовый вход. После того как весь байт проходит в сдвиговый регистр, подается 

команда выдать этот байт через параллельный интерфейс. Более подробная документация содержится по адресу: 

http://ardx.org/SHIF.

кон-
такт

3

кон-
такт

2



17

CIRC-05

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC05

его можно загрузить с http://ardx.org/CODE05
( )скопируйте текст и вставьте его в новое окно Arduino Sketch

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

Работает 

неправильно?
Скорее всего, перепутаны 

какие-то провода. 

Внимательно проверьте 

подключение.

Индикатор питания 

Arduino не горит
Возможно вы вставили 

микросхему сдвигового 

регистра наоборот. Если Вы 

быстро отключите питание и 

переустановите микросхему — 

ничего не должно испортиться.

Не получилось?

Напишите нам письмо с 

описанием проблемы. 

Постараемся помочь так 

быстро, насколько возможно.

 help@oomlout.com

Определение разъемов последовательность 74HC595 
//74HC595 использует протокол SPI  */
//у которого 3 разъема:
int data = 2; void updateLEDs(int value){
int clock = 3;  
int latch = 4;

void setup()  digitalWrite(latch, LOW);
//функция выполняется один раз //сигнал защелки установлен на LOW
{
  pinMode(data, OUTPUT);   shiftOut(data, clock, MSBFIRST, value);   
  pinMode(clock, OUTPUT);    //выдает 8 бит в сдвиговый регистр
  pinMode(latch, OUTPUT);  }      

  
void loop() digitalWrite(latch, HIGH);   
// функция выполняется бесконечно //открывает защелку - выводит информацию
{ }
  int delayTime = 100; 
//задержка между обновлениями светодиодов  

-----полная программа в электронной версии------  for(int i = 0; i < 256; i++){
   updateLEDs(i);
   delay(delayTime);   }
}

/*
 * updateLEDs() - посылает состояния 

светодиодов в виде значений переменной на 

КОД не надо набирать вручную,

ЕСТЬ ЕЩЕ ВОПРОСЫ?

Усложним задачу: оперировать с отдельными битами в байте. Подробное 
Arduino может делать сложные вещи относительно описание двоичных операций находится по адресу 
легко. Выдача данных через последовательный http://ardx.org/BITW.
интерфейс - одна из таких задач. Тем не менее эту Отредактируйте текст программы следующим образом:

int delayTime = 100;задачу возможно решить и более сложным образом (на 
       //время задержки в мс между циклами

Ваш выбор). Попробуйте изменить текст программы for(int i = 0; i < 8; i++){
changeLED(i,ON);следующим образом:
delay(delayTime);updateLEDs(i); замените на updateLEDslong(i);
}for(int i = 0; i < 8; i++){

Загрузите программу в контроллер и Вы убедитесь, что changeLED(i,OFF);
delay(delayTime);ничего не изменилось. Посмотрите на текст функции 
}

updateLEDslong(i); и Вы увидите, что передача 
Загрузите программу в Arduino. Светодиоды должны 

данных идет по одному биту (подробнее на 
загораться один за другим и так же гаснуть.

http://ardx.org/SPI).

Дополнительные эффекты:
Независимое управление светодиодами: Вы можете скопировать подпрограмму эффектов из 
Попробуем управлять светодиодами как в задании 

программы CIRC02 и заменить команду 
CIRC02. Состояние всех восьми светодиодов хранится 

digitalWrite(led,state) на changeLED(led,state).
при помощи одного байта (8 бит). Arduino может легко 



Arduino 
контакт 9

общий
вывод
(ground) (-)

пьезо-
элемент
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CIRC-06
.:Музыка

(пьезоэлемент):.

Провод
Пьезоэлемент

x1

х2 контактный
разъем
x4

Карточка задания
CIRC-06
x1

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS06
посмотреть

http://ardx.org/VIDE06

The Internet

Схема

Описание задания:

Компоненты:

в Интернете:

УСТРОЙСТВО:

До сих пор мы управляли светом, движением и 

электронами. Давайте попробуем управлять звуком. 

Звук, как известно, аналоговое явление. Возможно ли 

создавать звуки при помощи цифрового Arduino? 

Возможно, благодаря относительно высокой скорости работы 

микроконтроллера. Пьезоэлемент щелкает каждый раз, когда на него подается 

электрический импульс. Если посылать эти импульсы с определенной частотой 

(например 440 раз в секунду для воспроизведения ноты Ля), то щелчки 

превратятся в музыкальный тон. Давайте поэкспериментируем и заставим 

Arduino сыграть какую-нибудь мелодию.
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CIRC-06

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC06

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

его можно загрузить с
( )

 http://ardx.org/CODE06
скопируйте текст и вставьте его в новое окно Arduino Sketch

Не возможно думать, 

пока играет мелодия

Просто отключите 

пьезоэлемент от макетной 

платы, подумайте, затем 

подключите его обратно.

Нет звука
Благодаря форме и 

размерам пьезоэлемента 

легко промахнуться мимо 

правильных контактов на 

макетной плате. Проверьте 

расположение 

пьезоэлемента.

Изменение скорости: Написание собственной мелодии:

Для изменения скорости воспроизведения мелодии Программа играет 'Twinkle Twinkle Little Star’, но мелодию 

необходимо редактировать строку легко изменить. Каждая мелодия определяется одной 

переменной (число нот - int length) и двумя массивами. int tempo = 300; ---> 

Один массив, notes[] задает последовательность нот, int tempo = (новое значение)

другой, beats[] — длительность их звучания. Например:Для замедления темпа необходимо увеличивать это 

    Twinkle Twinkle Little Starчисло, для ускорения темпа — уменьшать.

   int length = 15; 
Подстройка нот:

   char notes[] = {"ccggaagffeeddc "}; 
Если Вам кажется, что какие-либо ноты звучат    int beats[] = { 1, 1, 1, 1, 1, 1, 2, 1, 1, 1, 1,   
фальшиво, вы можете их скорректировать. Для этого                    1, 1, 2, 4 };

необходимо редактировать соответствующую 
    Happy Birthday (first line)  

переменную в массиве tones[].    int length = 13; 
char names[] = { 'c', 'd', 'e', 'f', 'g', 'a',    char notes[] = {"ccdcfeccdcgf "}; 
'b', 'C' };

   int beats[] = {1,1,1,1,1,2,1,1,1,1,1,2,4}; 
int tones[] = { 1915, 1700, 1519, 1432, 1275, 
1136, 1014, 956 };

Устали от этой 

мелодии?
Программа готова, поэтому 

Вам надо лишь заменить ноты 

на другие.

/* Мелодия
 * (cleft) 2005 D. Cuartielles for K3     digitalWrite(speakerPin, 
 * LOW);
 * В этом примере мы проигрываем мелодию с помощью     delayMicroseconds(tone);
 * пьезоэлемента. Он посылает ШИМ-сигнал соответствующей   }
 * частоты, в результате генерируется музыкальный тон. }
 * Вычисление требуемой задержки осуществляется с помощью  
 * следующей формулы: void playNote(char note, int duration) {
 *   char names[] = { 'c', 'd', 'e', 'f', 'g', 'a', 'b', 'C' };
 *       timeHigh = period / 2 = 1 / (2 * toneFrequency)   int tones[] = { 1915, 1700, 1519, 1432, 1275, 1136, 1014, 956 
 *

}; * задержки задаются следующей таблицей:
    // проигрывать тональность соответствующую названию ноты *
  for (int i = 0; i < 8; i++) { * нота         частота (period)  timeHigh
    if (names[i] == note) { * c         261 Hz         3830 1915  
      playTone(tones[i], duration); * d         294 Hz         3400 1700  
    } * e         329 Hz         3038 1519  
  } * f         349 Hz         2864 1432  
} * g         392 Hz         2550 1275  

 * a         440 Hz         2272 1136  
void setup() { * b         493 Hz         2028 1014  
  pinMode(speakerPin, OUTPUT); * C         523 Hz         1912 956
} *

 * http://www.arduino.cc/en/Tutorial/Melody
void loop() { */
  for (int i = 0; i < length; i++) { 
    if (notes[i] == ' ') {int speakerPin = 9;
      delay(beats[i] * tempo); // паузаint length = 15; // число нот
    } else {char notes[] = "ccggaagffeeddc "; // пробел представляет паузу
      playNote(notes[i], beats[i] * tempo);int beats[] = { 1, 1, 1, 1, 1, 1, 2, 1, 1, 1, 1, 1, 1, 2, 4 };
    }int tempo = 300;
        // пауза между нотами
    delay(tempo / 2);   }void playTone(int tone, int duration) {
}  for (long i = 0; i < duration * 1000L; i += tone * 2) {

    digitalWrite(speakerPin, HIGH);
    delayMicroseconds(tone);
    

КОД не обязательно набирать вручную,

ЕСТЬ ЕЩЕ ВОПРОСЫ?
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CIRC-07
.:Нажатие

на кнопку (кнопки):.

Провод

Резистор 
Зеленый-синий-
коричневый
x1

560 Oм

х2 контактный разъем
x4

Красный светодиод
x1

Резистор 10 kOм
коричневый-черный
-оранжевый
x2

Arduino 
контакт 13

светодиод

резистор
(560Ом)

общий вывод
(ground) (-)

контакт 2

кнопка

+5 volts

Arduino

резистор
(10kОм)

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS07
посмотреть

http://ardx.org/VIDE07

Схема

Описание задания:

Компоненты:

УСТРОЙСТВО:

в Интернете:

До этого момента мы рассматривали различные варианты 

управления. Настало время научить Arduino слышать, 

смотреть и чувствовать. Начнем с простой кнопки. 

Подключить кнопку очень просто. Необходим только один 

компонент, подтягивающий резистор. Он необходим потому, что Arduino получает 

информацию не так как мы. Он не чувствует нажата кнопка или нет, вместо этого он 

контролирует значение напряжения на своем входе. Нажатие на кнопку приводит к 

обнулению напряжения (LOW) на входе, когда кнопка отжата, напряжение становится 

высоким (HIGH). Резистор необходим, чтобы на входе Arduino уверенно формировалась 

логическая единица когда кнопка отжата.

Обратите внимание: в первом примере используется только одна кнопка.

Кнопка
x2

Карточка задания
CIRC-07 
x1

контакт 3
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CIRC-07

/*
 * Кнопка
 * by DojoDave <http://www.0j0.org>
 *
 * Включаем и выключаем светодиод нажатием кнопки.
 * http://www.arduino.cc/en/Tutorial/Button
 */
int ledPin = 13;                // задаем номер выхода светодиода
int inputPin = 2;               // задаем номер входа, подключенный к кнопке
int val = 0;                    // переменная для хранения состояния кнопки

void setup() {
  pinMode(ledPin, OUTPUT);
// инициализируем контакт, подключенный к светодиоду, как выход
  pinMode(inputPin, INPUT);
//инициализируем контакт, подключенный к кнопке, как вход
}

void loop(){
  val = digitalRead(inputPin);  // считываем значения с входа кнопки
  if (val == HIGH) {            // проверяем нажата ли кнопка
    digitalWrite(ledPin, LOW);  // выключение светодиода
  } else {
    digitalWrite(ledPin, HIGH); // включение светодиода
  }
}

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC07

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

File > Examples > 2.Digital > Button
( )это пример с сайта arduino.cc, также там можно найти много отличных идей

КОД не надо набирать вручную, он находится по адресу:

Светодиод 

загорается плавно   

(тухнет)
Не забудьте переключить 

светодиод с порта 13 на порт 

9 для этого задания.

не Светодиод не 

включается
Кнопка квадратная, поэтому 

ее легко вставить повернув 

на 90 градусов. Проверьте 

правильность подключения 

кнопки.

Кнопка включения и кнопка выключения: Плавное включение/выключение светодиода:
Первый пример может немного разочаровать (например, «мне Давайте используем кнопку для управления аналоговыми 
не нужен Arduino, чтобы сделать это»), давайте его немного сигналами. Для этого необходимо переключить светодиод с порта 
усложним. Одна кнопка будет включать светодиод, а другая 13 на порт 9 и изменить программу:
выключать. Измените программу следующим образом: int ledPin = 13; ----> int ledPin = 9;
int ledPin = 13; Теперь измените функцию loop() следующим образом:
// выберите разъем для светодиода

int value = 0;int inputPin1 = 3;      // кнопка 1
void loop(){int inputPin2 = 2;      // кнопка 2
  if (digitalRead(inputPin1) == LOW) { value--; } 

void setup() {   else if (digitalRead(inputPin2) == LOW) { value++; }
  pinMode(ledPin, OUTPUT);   value = constrain(value, 0, 255);
// светодиод задается как выход   analogWrite(ledPin, value);
  pinMode(inputPin1, INPUT); // кнопка 1 - вход   delay(10);
  pinMode(inputPin2, INPUT); // кнопка 2 - вход }
}

Изменение скорости включения/выключения светодиода:void loop(){
Если Вы хотите, чтобы светодиод загорался или гас быстрее,   if (digitalRead(inputPin1) == LOW) { 

    digitalWrite(ledPin, LOW);  // выключение необходимо изменить только одну команду в программе:
светодиода delay(10);  ----> delay(новое значение);
  } else if (digitalRead(inputPin2) == LOW) {      
    digitalWrite(ledPin, HIGH); // включение Для ускорения эффекта необходимо уменьшать это число. Для 
светодиода } замедления включения/выключения это число необходимо 
} увеличить.
Загрузите программу и проверьте работоспособность.

 

Разочарованы?
Не беспокойтесь, все 

устройства в этом наборе 

упрощены до предела, чтобы 

было проще понять основы. 

Когда Вы разберетесь в 

основах — перед вами 

откроются неограниченные 

возможности.

ЕСТЬ ЕЩЕ ВОПРОСЫ?



Компоненты:

.:Кручение

(потенциометры):.

Провод
х2 контактный разъем

x4
Карточка задания
CIRC-08 
x1

Зеленый светодиод
x1

Arduino 
контакт 13

свето-
диод

резистор (560Ом)
(зеленый-синий-
коричневый)

общий вывод
(ground) (-)

потенциометр

+5 Вольт

Arduino 
аналоговый

вывод 2

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS08
посмотреть

http://ardx.org/VIDE08

Схема

Описание задания:
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CIRC-08

УСТРОЙСТВО:

в Интернете:

Кроме цифровых портов Arduino оборудован шестью 

портами, которые могут быть аналоговыми входами. При 

помощи такого входа можно преобразовать напряжение 

в диапазоне 0...5В в цифровой код с диапазоном 0...1023 

(соответствует разрешению 10 бит). Потенциометр 

(переменный резистор) это очень полезное устройство, которое можно использовать 

совместно с таким входом. Когда потенциометр подключен крайними выводами к 

«земле» и к +5В, на среднем выводе будет присутствовать некое напряжение из 

диапазона 0...5В, зависящее от положения движка потенциометра (угла поворота). В 

среднем положении значение на среднем выводе будет соответствовать 2.5В. Можно 

использовать измеренное значение напряжения на среднем выводе потенциометра в 

качестве переменной в программе.

Резистор 
Зеленый-синий-
коричневый
x1

560 Oм

Потенциометр 
10 кОм
x1



Не работает
Убедитесь, что не 

подключили средний вывод 

потенциометра к цифровому 

входу 2 вместо аналогового 

входа 2 (аналоговые входы 

находятся в одном ряду с 

разъемом питания).

/*  
 * Демонстрирует аналоговый вход, считывая значение аналогового сенсора со входа 0 и включая и 
 * выключая светодиод, подключенный к цифровому выводу 13. Время пребывания светодиода во
 * включенном или выключенном состоянии зависит от значения, полученного при помощи analogRead().
 * Created by David Cuartielles
 * Modified 16 Jun 2009
 * By Tom Igoe
 * http://arduino.cc/en/Tutorial/AnalogInput
 */

int sensorPin = 0;    // задаем номер входа для потенциометра
int ledPin = 13;      // задаем номер выхода светодиода
int sensorValue = 0;  // переменная для хранения значения, поступающего с сенсора

void setup() {
  pinMode(ledPin, OUTPUT);  //инициализируем контакт, подключенный к светодиоду, как выход
}

void loop() {
  sensorValue = analogRead(sensorPin);// считываем значения с сенсора
  digitalWrite(ledPin, HIGH);         // включает светодиод
  delay(sensorValue);                 // задержка на <sensorValue> в миллисекундах
  digitalWrite(ledPin, LOW);          // выключает светодиод        
  delay(sensorValue);                 // задержка на <sensorValue> в миллисекундах
}

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC08

 Потенциометр 

периодически перестает 

работать
Это возможно из-за плохого 

контакта выводов 

потенциометра. Попробуйте 

прижать потенциометр плотнее к 

макетной плате.

Все еще н
Попробуйте изменить 

полярность подключения 

потенциометра. Иногда это 

помогает.

е работает
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CIRC-08

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

File > Examples > 3.Analog > AnalogInput
( )это пример с сайта arduino.cc, также там можно найти много отличных идей

КОД не надо набирать вручную, он находится по адресу:

Пороговый переключатель: текст программы:
int ledPin = 13; ----> int ledPin = 9;Иногда необходимо переключать что-то при достижении 

Измените фунцию loop на:измеренным параметром заданной величины (например 
  void loop() {

отключать подачу воды в стиральную машину, при    int value = analogRead(potPin) / 4;
   analogWrite(ledPin, value);достижении заданного уровня). Чтобы сделать это с 
  }

потенциометром необходимо изменить программу 
Загрузите программу в микроконтроллер и убедитесь, что 

следующим образом:
яркость светодиода зависит от положения движка void loop() {
потенциометра. Мы разделили измеренное значение на 4,   int threshold = 512;

  if(analogRead(sensorPin) > threshold){ потому что яркость может изменяться только в пределах 0...255 
digitalWrite(ledPin, HIGH);} (8 бит) , тогда как функция  analogRead() - в пределах   else{ digitalWrite(ledPin, LOW);}

0...1024 (10 бит).}

Светодиод будет включаться/выключаться при Контроль сервопривода:
достижении среднего значения. Вы можете изменить Это интересный пример, объединяющий два устройства в одном. 
чувствительность, путем редактирования параметра Подключите сервопривод как в задании CIRC-04, откройте 
threshold. пример File>Examples>Servo>Knob, измените строку:

int potpin = 0; ----> int potpin = 2;Контроль яркости:
Загрузите программу в микроконтроллер и убедитесь, что Можно управлять яркостью светодиода непосредственно 
положение потенциометра определяет положение при помощи потенциометра. Для этого необходимо 
сервопривода. переключить светодиод с порта 13 на порт 9 и изменить 

ЕСТЬ ЕЩЕ ВОПРОСЫ?
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CIRC-09
.:Свет

(фоторезисторы):.

Провод

Карточка задания
CIRC-09 
x1

Arduino 
контакт 13

свето-
диод

резистор
(560 Ом)

общий вывод
(ground) (-)

+5 Вольт

фото-
резистор

резистор
(10 кОм)

Arduino 
аналоговый

вход 0

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS09
посмотреть

http://ardx.org/VIDE09

Схема

Описание задания:

Компоненты:

УСТРОЙСТВО:

в Интернете:

В предыдущем задании мы рассмотрели потенциометр, 

который может использоваться для ввода информации 

человеком. Существуют разнообразные сенсоры, 

позволяющие получить информацию об окружающей 

обстановке. Например фоторезистор может использоваться в качестве датчика 

освещенности. Принцип работы с Arduino не изменяется. Arduino не может 

непосредственно измерять сопротивление (можно измерять напряжение), поэтому 

фоторезистор включается как часть делителя напряжения (http://ardx.org/VODI). 

Можно рассчитать точное значение напряжения на аналоговом входе, но для нашей 

задачи это не нужно. Будем измерять относительный уровень освещенности. Малые 

значения будут соответствовать яркому свету, большие значения — темноте.

Резистор 10 kOм
коричневый-черный
-оранжевый
x2

х2 контактный
разъем
x4

Резистор 
Зеленый-синий-
коричневый
x1

560 Oм

Фоторезистор
x1

Зеленый светодиод
x1



Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC09

его можно загрузить с 
( )

http://ardx.org/CODE09
скопируйте текст и вставьте его в новое окно Arduino Sketch

/*   pinMode(ledPin, OUTPUT); 
 * Простая программа, изменяющая интенсивность //инициализируем //контакт, подключенный к 
 * свечения светодиода на основе количества //светодиоду, как выход
 * света, падающего на фоторезистор. }
 */  /*

 * функция loop() начнется после окончания функции
//PhotoResistor Pin  * setup и будет повторяться
int lightPin = 0;  //аналоговый вход к которому  */
// присоединен фоторезистор. void loop()
// фоторезистор не откалиброван по каким-либо {
// единицам измерения, а просто выдает напряжение  int lightLevel = analogRead(lightPin);
// пропорциональное уровню освещенности           //считываем уровень освещенности

value (relative light)  lightLevel = map(lightLevel, 0, 900, 0, 255); 
//LED Pin //выставляем значение переменной в пределах 0-900
int ledPin = 9;   lightLevel = constrain(lightLevel, 0, 255);
//контакт к которому подключен светодиод. //ограничиваем значение переменной промежутком 0-255
//мы контролируем яркость, поэтому используем   analogWrite(ledPin, lightLevel);  

//выводим значение переменнойаналоговый выход ШИМ (Широтно-Импульсная 
}модуляция)

void setup()
{
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Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

КОД не надо набирать вручную,

Все еще не работает?
Возможно в комнате, где Вы 

проводите эксперимент, 
слишком темно или наоборот 
слишком светло. Попробуйте 
включить/выключить свет — 

возможно это поможет.

Если у вас есть под рукой 
фонарь — попробуйте осветить 

им датчик.

Устройство не 

реагирует на изменение 

освещенности
Проверьте правильно ли 

подключен фоторезистор.

Светодиод остается 

темным
Очень часто светодиод 

подключается с 

несоблюдением полярности. 

Попробуйте повернуть его на 

180 градусов.

Инвертирование выхода: Сервопривод, управляемый светом:

Возможно Вы хотите, чтобы светодиод работал в Давайте используем этот сенсор для управления 

инверсном режиме. Для этого отредактируйте сервоприводом. Подключите сервопривод к порту 9 (как в 
программу следующим образом:

CIRC-04). Загрузите в контроллер программу Knob File >  analogWrite(ledPin, lightLevel); ----> 
analogWrite(ledPin, 255 - lightLevel); Examples > Servo > Knob (пример из CIRC-08). Посмотрите 

Ночник: как будет работать сервопривод.
Вместо того, чтобы изменять яркость светодиода в 

Вы наверняка обратили внимание, что сервопривод 
зависимости от освещенности, можно просто 

работает не во всем диапазоне. Это происходит потому, включать и выключать его. Замените текст 
подпрограммы loop() следующим образом: что благодаря делителю напряжения мы работаем в 
  void loop(){

меньшем диапазоне, чем 0...5В. Это можно      int threshold = 300;
     if(analogRead(lightPin) > threshold){ скорректировать при помощи команды val = 
       digitalWrite(ledPin, HIGH);

map(val,0.1023,0,179); Подробное объяснение этой      }else{
       digitalWrite(ledPin, LOW);    функции можно найти по адресу 
     }

http://arduino.cc/en/Reference/Map.}

ЕСТЬ ЕЩЕ ВОПРОСЫ?
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CIRC-10 .:Температура
(температурный датчик ТМР36):.

Что еще можно измерить при помощи Arduino? Температуру! 

Для измерения температуры будем использовать достаточно 

сложную микросхему, спрятанную в корпусе аналогичном 

корпусу транзистора P2N222AG. Эта микросхема имеет три 

вывода: «земля», сигнал и питание +5В. Она выдает 10мВ/градус 

Цельсия (чтобы измерять отрицательные температуры предусмотрен сдвиг напряжения на 

500 мВ, т. е. 25°С = 750 мВ, 0°С = 500 мВ). Чтобы преобразовать значение напряжения в 

температуру будем использовать математические способности Arduino. Для отображения 

температуры используем отладочное окно интерфейса Arduino. Будем посылать значения 

температуры через последовательный порт для отображения на экране компьютера.

Это устройство использует монитор последовательного порта. Чтобы запустить его 

необходимо загрузить программу в Arduino, затем нажать кнопку похожую на прямоугольник 

с антенной:

Документация по датчику TMP36: http://ardx.org/TMP36

Провод
Температурный
датчик TMP36
x1

х2 контактный
разъем
x4

Карточка задания
CIRC-10
x1

+5 Вольт

TMP36
(температурный

датчик)

общий
вывод
(ground) (-)

gnd

+5В
сигнал

имеет маркировку
“TMP36”

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS10
посмотреть

http://ardx.org/VIDE10

Компоненты:

в Интернете:

Схема

Описание задания:

УСТРОЙСТВО:

Arduino 
аналоговый

вход 0
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CIRC-10

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC10

его можно загрузить с 
( )

http://ardx.org/CODE10
скопируйте текст и вставьте его в новое окно Arduino Sketch

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

Отображаются 
странные данные

Скорее всего это происходит 

из-за того, что Ваш монитор 

последовательного порта 

принимает данные не с той 

скоростью. Переключите 

скорость работы монитора на 

«9600 baud».

Ничего не происходит

Эта программа не 

использует индикацию. Для 

того чтобы увидеть 

результат, Вам необходимо 

запустить монитор 

последовательного порта.

---->Отображение напряжения:
 Serial.print(temperature); 

Это очень просто сделать, поскольку сенсор уже Serial.println(" degrees centigrade");
выдает напряжение. Достаточно удалить строку Изменения в первой строке означают, что следующий 
delete the line   temperature = (temperature - .5) * 100;     вывод данных будет осуществляться в ту же строку на 
Отображение температуры в Фаренгейтах: дисплее. Следующая строка выводит вспомогательную 
Это тоже несложно, поскольку затрагивает только информацию и осуществляет переход на новую строку.
вычислительную часть. Чтобы перейти от градусов 

Изменение скорости передачи:
Цельсия к градусам Фаренгейта необходимо 

Если Вы собираетесь посылать большой объем 
использовать следующую формулу:

информации через последовательный порт, то имеет ( F = C * 1.8) +  32 )  
смысл делать это так быстро, насколько возможно. В добавьте строку  

temperature = нашем примере мы передаем данные на скорости 9600 
(((temperature - .5) * 100)*1.8) + 32; бод, однако возможно использовать намного большие 

перед строкой  Serial.println(temperature); скорости. Измените строку:
  Serial.begin(9600); ----> Serial.begin(115200);Более информативный вывод данных:

Давайте добавим сообщение к данным, посылаемым Таким образом, скорость передачи увеличивается в 12 
через последовательный порт. Вернитесь к раз. Не забудьте изменить скорость работы монитора 
исходной программе, затем замените: последовательного порта.

 Serial.println(temperature); 

Значение 
температуры не 

изменяется
Прикоснитесь к сенсору 

пальцем, чтобы нагреть его. 
Или используйте кусочек 

льда, чтобы охладить 
сенсор.

/* ---------------------------------------------
 * |  Экспериментальный набор Arduino          |
 * |  пример программы для задания CIRC-10     | temperature = (temperature - .5) 
 * |  .: Температурный датчик :.               | * 100;
 * --------------------------------------------- //переводит полученное значение из 10мВ/градус в градусы 
 *  Простая программа для вывода текущей температуры      (напряжение - 500мВ)x100
 *  на монитор последовательного порта

 Serial.println(temperature); //выводим результат
 //TMP36 Pin Variables  delay(1000);                 //задержка 1 сек
int temperaturePin = 0; }
   // задаем аналоговый вывод, к которому присоединен 

выход датчика TMP36. Разрешение - 10мВ/градус цельсия /*
(смещение на 500мВ для отображения негативных  * getVoltage() - возвращает значение напряжения на 

температур) аналоговом входе
 */

void setup() float getVoltage(int pin){
{ return (analogRead(pin) * .004882814);
  Serial.begin(9600);  //преобразует значение в цифровом диапазоне 0...1024 в 
//открываем последовательное соединение. Для диапазон 0...5 мВ (каждое показание ~ 5 милливольт)
отображения результата необходимо запустить монитор }

последовательного порта (последняя кнопка под главным 

меню, выглядит как прямоугольник с антенной)
}
 
void loop()                     // бесконечный цикл
{
 float temperature = getVoltage(temperaturePin);  
/*получает значение напряжения с температурного 

датчика*/

КОД не надо набирать вручную,

ЕСТЬ ЕЩЕ ВОПРОСЫ?
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CIRC-11
.:Большие нагрузки

(реле):.

Последние задания всегда в какой-то степени являются 

испытанием. Мы используем наши знания о транзисторах 

(CIRC03) чтобы управлять реле. Реле - это управляемый 

электронно-механический переключатель. Внутри пластиковой 

коробочки содержится электромагнит,  при подаче питания на который происходит 

переключение механического контакта (обычно с заметным щелчком). Различные реле 

очень сильно отличаются по размерам и параметрам (от совсем крошечных, до реле 

размером с холодильник). Обычно, чем больше размер реле — тем больший ток оно 

способно коммутировать. При помощи реле и Arduino Вы сможете управлять чем-то 

значительным.

х2 контактный
разъем
x4

Карточка задания
CIRC-11 
x1

Резистор 2.2 кOм
красный-красный
-красный
x1

Резистор 560 Oм
Зеленый-синий-
коричневый
x2

Arduino 
pin 2

резистор
(2.2кОм)

общий вывод
(ground) (-)

коллектор эмиттер

база

+5 вольт

транзистор
P2N2222AG 

о
б
м

о
тка

общийзакроткр диод

Диод
(1N4001)
x1

транзистор маркирован
“P2N2222AG”
(у некоторых разновидностей
выходы расположены
в обратном порядке)

.:скачать:.
карточку задания

.: :.
видео сборки

http://ardx.org/BBLS11
посмотреть

http://ardx.org/VIDE11

в Интернете:

Схема

Описание задания:

Компоненты:

УСТРОЙСТВО:

Реле
(DPDT)
x1

Транзистор
P
x1

2N2222AG (TO92)

Зеленый
светодиод
x1

Красный
светодиод
x1



Визуализация импульсов обратного тока
Замените диод светодиодом. Вы увидите мигание каждый раз, когда реле будет отключаться.

Управление мотором
В задании CIRC03 мы управляли мотором при помощи транзистора. Однако, если вы 

собираетесь управлять более мощным мотором, реле будет лучшим вариантом. Для этого 

просто снимите красный светодиод и вместо него подключите мотор (не забудьте убрать 

резистор 560 Ом).

Изменение направления вращения мотора
Немного усложним устройство напоследок. Для изменения направления 

вращения мотора постоянного тока необходимо изменить направление 

протекания тока.Если это делать вручную — достаточно поменять местами 

провода. Для электронной коммутации необходимо использовать что-то 

вроде H-моста. Это можно сделать при помощи DPDT реле. Соберите 

следующую схему: 

Нет щелчков (звуков 

переключения реле)

Возможно не работает 

транзистор. Тщательно 

проверьте правильность 

установки.
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CIRC-11
File > Sketchbook > 1.Basic > Blink
( )это пример с сайта arduino.cc, также там можно найти много отличных идей
/* Мигание
 *
 * Простой пример: программа включает светодиод на 1 секунду, потом выключает на 1 

секунду, и тд.. Мы используем вывод 13, потому что в зависимости от того, какой у вас 

Ардуино, у него есть либо встроенный светодиод, либо резистор и тогда вам нужен 

только светодиод.
 *
 * http://www.arduino.cc/en/Tutorial/Blink
 */

int ledPin = 2;                 // ***********  CHANGE TO PIN 2 ************

void setup()                    // выполняется один раз, потом запускается скетч
{
  pinMode(ledPin, OUTPUT);      // инициализируем цифровой контакт как выход
}

void loop()                     // функция выполняется бесконечно
{
  digitalWrite(ledPin, HIGH);   // включает светодиод
  delay(1000);                  // задержка 1 сек
  digitalWrite(ledPin, LOW);    // выключает светодиод
  delay(1000);                  // задержка 1 сек
}

Подробности, где купить детали к проекту, где задать вопросы:

http://ardx.org/CIRC11

Не совсем работает
Включенное в набор реле 

рассчитано на пайку, а не на 

установку в макетную плату. 

Возможно поможет если Вы 

прижмете его к макетной 

плате с небольшим усилием.

Ничего не происходит
Программа использует порт 13, 

а наше реле подключено к 

порту 2. Не забудьте 

соответственно 

отредактировать программу.

Arduino 
контакт 2

резистор
(2.2кОм)

общий вывод
(ground) (-)

коллектор эмиттер

база

+5 вольт

транзистор
P2N2222AG 

о
б
м

о
тка

общийзакроткр диод

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

КОД не надо набирать вручную, он находится по адресу:

ЕСТЬ ЕЩЕ ВОПРОСЫ?



Компоненты:

.:скачать:.
карточку задания

http://ardx.org/BBLS12R 

в Интернете:
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CIRC-12
.:Многоцветное

свечение
(светодиоды RGB):.

Вы можете мигать светодиодами и использовать ШИМ 

для управления моторами. Давайте применим эти 

знания и создадим светодиод, который может светиться 

любым цветом  и с любой интенсивностью (на основе RGB 

светодиода).

RGB светодиод представляет собой три светодиода — R красный, G зеленый и B 

синий в одном корпусе. Используя различные комбинации этих трех цветов можно 

синтезировать практически любой цвет.

Для контроля каждого канала RGB светодиода используется обычный светодиод, 

таким образом смешение цветов происходит наглядно.

Описание задания:

УСТРОЙСТВО:

Резистор 560 Oм
Зеленый-синий-коричневый
x6

х2 контактный
разъем
x4

Карточка задания
CIRC-RGB 
x1

Провод
Светодиод
RGB 5мм
x1

Красный светодиод
x1
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Подробности, где купить детали к проекту, где задать вопросы:

Все слишком красное
Возможно красный 

светодиод в RGB 

светодиоде светится ярче 

остальных. Это можно 

скорректировать путем 

увеличения резистора в 

канале R.

Слишком много 
светодиодов?

Одноцветные светодиоды 

используются для индикации 

сигналов в каналах RGB. После 

того как Вы разберетесь как 

это работает — можете их 

удалить.

Светодиод не загорается, 

или показывает 

неправильные цвета
Проверьте внимательно 

подключение RGB светодиода. 

Не забудьте про подключение 

общего вывода к «земле».

http://www.solarbotics.com

CIRC-12

Не работает? (3 проблемы и их решения)

Усовершенствуем устройство

его можно загрузить с 
( )

http://ardx.org/CODE12R
скопируйте текст и вставьте его в новое окно Arduino Sketch

Больше цветов Аналоговый контроль цвета

Наверное вы не очень удивлены голубым Переключаться между фиксированными цветами 

цветом светодиода. Чтобы изменить его цвет достаточно интересно. Но если использовать 
на другой — отредактируйте программу: аналоговый контроль, можно получить 
setColor(ledDigitalOne, CYAN); ---->

практически неограниченное количество цветов. setColor(ledDigitalOne, **NEW COLOR**);    

Загрузите пример по адресу: 
Отображение случайных цветов

 http://ardx.org/MABE12R
Конечно мы можем больше, чем просто 

показывать постоянные цвета. 

Отредактируйте программу следующим 

образом:
void loop(){
   //setColor(ledDigitalOne, CYAN);    
   randomColor()
}

//RGB LED pins   for(int i = 0; i < 3; i++){
int ledDigitalOne[] = {9, 10, 11};    pinMode(ledDigitalOne[i], OUTPUT);   
   //3 цифровых вывода светодиодов //инициализирует выводы 3х светодиодов как выходы
   //9 = redPin, 10 = greenPin, 11 = bluePin   }

}
const boolean ON = LOW;     
//задаем включенное состояние как LOW void loop(){
// (потому что мы используем RGB светодиод с   setColor(ledDigitalOne, CYAN);    

      //задает цвет светодиода// общим анодом) общий вывод подключен к +5В
const boolean OFF = HIGH;   

  //randomColor()  //задаем выключенное как HIGH
  
}//Заданные цвета

const boolean RED[] = {ON, OFF, OFF};    
void randomColor(){const boolean GREEN[] = {OFF, ON, OFF}; 
  int rand = random(0, sizeof(COLORS) / 2);  const boolean BLUE[] = {OFF, OFF, ON}; 
    //возвращает случайное число из диапазона цветовconst boolean YELLOW[] = {ON, ON, OFF}; 
  setColor(ledDigitalOne, COLORS[rand]);  const boolean CYAN[] = {OFF, ON, ON}; 
    //задает цвет светодиода как случайныйconst boolean MAGENTA[] = {ON, OFF, ON}; 
  delay(1000);const boolean WHITE[] = {ON, ON, ON}; 
}const boolean BLACK[] = {OFF, OFF, OFF}; 

void setColor(int* led, boolean* color){//массив хранящий заданные цвета
 for(int i = 0; i < 3; i++){const boolean* COLORS[] = 
   digitalWrite(led[i], color[i]);  {RED, GREEN, BLUE,YELLOW, CYAN, MAGENTA, 
 }   WHITE, BLACK};
}

void setup(){

КОД не надо набирать вручную,

ЕСТЬ ЕЩЕ ВОПРОСЫ?
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ЗАМЕТКИ .:Место для записей:.
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.:Место для записей:. ЗАМЕТКИ
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